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	Aim/Purpose
	[In a sentence or two, explain the need for this paper. What is the problem?]
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	[Explain in a sentence or two in what way this paper addresses the problem.] 
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Briefly describe any research sample.]
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Using this File to Format your Paper 
If you are not using Word as your word processor, print this document and read more about the required formatting guidelines. However, if you are using Word, you can (and should) save time by using this file to attach the correct paragraph formatting to your paper. This file contains not only instructions for you, but also instructions for Word on how to format paragraphs as Heading 1, Heading 2, and such. 
Recent versions of Word use style sets to define the formatting of paragraph styles. Style sets allow you to format all elements in your document at once instead of modifying each element separately. This document has the most frequently used styles for books. To see the styles, click on the Home tab and the styles are displayed in the Styles group. Saving the styles as a new style set will enable to you apply the styles in this document to your document.
[bookmark: _2s8eyo1]Different versions of Word have different ways of saving these formatting styles on your computer.  First, open this document on your computer.
For Word 2013 and later (including Word 365) do the following.
1. Click the Design tab in the Ribbon.
2. A list of style sets will appear
3. Click the drop-down arrow and a display of all the available style-sets will appear.
4. Click Save as New Style Set. A dialog box appears.
5. Enter a name for the Style Set 
6. Click Save. This will be saved in Microsofts QuickStyles folder.
7. This style set will now appear under the Custom style sets.
For Word 2010 do the following.
1. Click the Home tab in the Ribbon.
2. Click Change Styles in the Styles group. A drop-down menu will appear.
3. From the drop-down menu, select Style Set.
4. Click Save As Quick Style Set. A dialog box appears.
5. Enter a name for the Style Set.
6. Click Save. 
Using the Style Set
1. Open a new or existing document.
2. Click the Design tab in the Ribbon. (For Word 2010, click the Home tab.)
3. A list of style sets will appear.
4. Click the drop-down arrow and look through the display of the Custom style-sets.
5. Select the Style Set you wish to use.
6. The paragraphs that use one of the styles in that Custom style set will format according to that style
If you don’t want to save the styles, save this document under a new name. Delete from the top of page 2 to the end. You will have the correct formatting for the first page and the paragraphs, as well as the paragraph styles and can copy and paste your paper into it. 
General Information
Prepare your manuscript in Microsoft Word or export it from a different word processor into RTF format, following the specifications that we show here.
One of the most important guidelines is that we must be able to move and resize figures easily. How to make this possible is described in the section on figures and tables.
For papers that deal with data analysis, make the data available to readers via a link you place in your paper to a website where you store your data, if at all possible.  We can help.
When you submit your paper for review, make sure that you have anonymized your paper by removing all references to yourself or your institution. Make sure these are removed from the document properties as well. To have your paper reviewed, you need first to submit a “blinded” version (without author or affiliation information) that can be blind reviewed. After your paper is accepted, add the author information.
Language and Grammar Consistency
We publish papers written in English. If you have questions on English grammar or punctuation, search the web for guidance. You can find excellent guides at http://www.grammarbook.com and http://guidetogrammar.org/grammar/index.htm 
While we prefer the use of U.S. spelling, we accept other versions of English as long as they are used consistently throughout the paper.
[bookmark: _17dp8vu]Use of the singular “they”
[bookmark: _3rdcrjn]When the gender of a person is unknown, the use of the singular “they” is accepted. Do not use expressions such as “s/he” or “his or her.” For example, “Each student submitted their art portfolio to the committee” is correct. If using the singular “they” as a generic third-person pronoun seems awkward, try rewording the sentence or using the plural, such as “All students submitted their art portfolios to the committee” or “The art portfolio of each student was submitted to the committee.” More information about this is at https://apastyle.apa.org/blog/singular-they and https://apastyle.apa.org/style-grammar-guidelines/grammar/singular-they  
Content
First Page Layout
To put the first page of your document in the proper format, copy the content of the first page from this file into your document and fill in the abstract information.
Author information (added after paper has been accepted)
Once the Editor has accepted your paper, insert the full name, the affiliation (University or Company), City, Country, and email address for each author into the table on the first page. Insert additional rows if there are more than two authors. If there is more than one author, place an asterisk after the corresponding author’s name.
Also include one or two short paragraphs and a head-and-shoulders photo (if available) for each author at the end of the paper.  
What to put in the abstract 
The abstract is a brief summary of the contents of the article; it should give enough information to make the reader want to learn more about your research, but it needs to be concise. In each of the boxes on the first page, enter one or two brief sentences appropriate for your paper. Omit citations from the abstract; citations for the paper’s sources do appear in the body of the paper.
If any of the abstract subtopics do not apply to your paper, put “NA” in that box.
Body of Paper
Introduction or background
All papers should begin with an introduction that sets the stage for the discussion. For some disciplines, it is more appropriate to use Background as an alternative first section.
Body
The body is a collection of multiple sections describing the main content of the paper. You should use up to three levels of headings to categorize content as deemed necessary: Heading 1, Heading 2, and Heading 3.
Conclusion
This section summarizes the paper, presents challenges, suggests future study, and so on to create a lasting impression of the paper.
Appendix
If there is an appendix, place it after the References and before the Biography. If there is more than one appendix, add a letter after “Appendix.”
If you have used a questionnaire in a study, include a copy of it as an appendix.
References
Following the conclusion is a list of all references used in the body of the paper. The current APA formatting guidelines are used to make internal citations within the body as well as provide the complete alphabetic list of reference citations at the end of the paper. (See the Entering References section for more details. We have placed a summary of these guidelines at https://www.informingscience.org/Uploads/APA_7ed.pdf ) The References list contains only works cited in the paper and all works cited in the paper must be listed in the References section. 
Author Information with Picture
After the paper is accepted, for each author of the paper, please provide a one or two paragraph biography that describes the author’s background relevant to this article. If you have one, insert a head-and-shoulder photo to the left of the biography of each author or send it separately and we will insert it.
Page Formatting
To make it easier to read the paper online, use single column formatting for the paper.
Page Size
Set the paper size to Letter, which is 8 1/2 by 11 inches.
Margins
Select Mirror Margins. Top and bottom margins should be 1 inch. Set the inside margin to 1.5 inches and the outside margins to 1 inch. (If you have problems doing this, leave the left and right margins at 1.25 inches.)
Headers and Footers
Insert page numbers in the footer. We will add the remaining information for the headers, and footers. 
Hyphenation
Hyphenate the text in the document. To turn on hyphenation:
· Select Language on the Layout or Page Layout menu.
· Select Hyphenation.
· Check Automatically hyphenate document.
Footnotes
Footnotes should not be used at all. Insert your note within the body of the paper (if it is important) or omit it. The editors will remove most footnotes and place the material within the text. 
Paragraph Styles (This is a Heading 1 Style)
If you have not attached these styles to your paper, use Word’s default paragraph styles for your document, making just the changes indicated below. 
Headings (This is a Heading 2 Style)
Do not number headings. Enter the headings with no outline numbers or letters in front of them. 
Paper title 
Use the Paper Title style for the title of your paper. It is centered with a border under it. The font for this style is Garamond, 16 point, Bold, and Small Caps.
The paragraph formatting is Centered with a 6 point space after it and an underline border at the bottom. The “Keep with Next” property is selected.
Capitalize the first letter of every major word. Do not use all upper case.
First level headings
Use the Heading 1 style for the title and for major headings. The font for this style is Garamond, 16 point, Bold, and Small Caps. 
The paragraph formatting has a 3 point space before and a 6 point space after it and an underline border at the bottom. The “Keep with Next” property is selected.
Capitalize the first letter of every major word. Do not use all upper case.
Second level headings
Use the Heading 2 style for second level headings. The font for this heading is Garamond, 14 point, Bold, Italic and Small Caps. The space before the paragraph is 12 point and the space after is 3 point. The “Keep with Next” property is selected.
Capitalize the first letter of every major word in second level headings. Do not use all upper case.
Third level headings (This is a heading 3 style)
Use the Heading 3 style for third level headings. The font for this heading is Garamond, 12 point, Bold. The space before the paragraph is 12 point and the space after is 3 point. The “Keep with Next” property is selected. 
Capitalize only the first word and proper nouns in this heading.
Text Paragraphs
Use the Normal style for paragraphs of text. The paragraph is single-spaced with no indentation and has a 6-point space after it. The font for this style is 11 point Garamond. Do not put blank lines between paragraphs.
Other types text of paragraphs
Forth level. Three levels of headings are enough for most papers. If you need another level, such as for this paragraph, use the Normal style and place the heading at the beginning of the paragraph in bold font.
Lists. Use Word’s automatic bullet or number formats for lists.
References: Use a 10 point Garamond font with a hanging indent of 0.25 inches.
Other. Use other formats only when absolutely necessary.
Figures and Tables
A table is data presented in tabular format with rows and columns. A figure is any other pictorial representation of data such as graphs or drawings. Each figure or table must be numbered and have a brief caption that describes it. Every figure or table must be referenced in the body of the paper. Table 1 is an example of a table and Figure 1 is an example of a figure.
Table 1. Example of a table
	ID#
	LAST
	FIRST
	CATALOG #
	CATEGORY
	QUANTITY
	AMOUNT
	COMMISSION

	S00001
	Golden
	Rod
	M00002
	Multiple
	2
	$250.00
	$12.50

	S00001
	Golden
	Rod
	M00012
	Hiking
	1
	$50.00
	$2.50

	S00001
	Golden
	Rod
	M00028
	Multiple
	1
	$95.00
	$4.75

	S00002
	Red
	Rose
	M00038
	Multiple
	1
	$35.00
	$1.92
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Figure 1. Example of a figure
The caption for tables is placed above the table; the caption for figures is placed below the figure.
All accepted papers need to be reformatted before publication; therefore, it is important that all figures and tables can be easily resized and/or moved. Since tables and figures may be moved during the final formatting, do not use “above” or “following” when referring to them; just give the table or figure number. Also, do not use automatic numbering of tables and figures as these can become corrupted when figures or tables have to be rearranged. Tables and figures may be inserted directly into the paper or placed on separate pages at the end of the paper.
There are two ways to submit figures.
1. insert the figure, formatted as a picture that can be resized. It is best if it is inserted directly into the paper with “in line” wrapping.
2. send figures as PowerPoint slides in a separate file and, within the paper, indicate where they are to appear,
Do not send figures formatted as separate text boxes or groups of images on the page. 
Copyright and Creative Common License
We will publish your paper under a Creative Commons Attribution-NonCommercial 4.0 International License and the author retains the copyright.
By submitting the paper, as author you certify the following:
1. You hold copyright for this submission, and
2. You warrant that you have not infringed on any copyright and assume full liability in case of copyright dispute.
Copyright Issues for Figures
There are three common sources of figures. 
1. Figures you have copied from another source, including a web site. You must contact the holder of the copyright for the image and get permission to use it. Cite the source and add “used with permission.”
2. Figures that you create based on another’s work. You do not need to get permission but include in the citation “adapted from” or “based on” and give the source.
3. Figures that are your original work. Since you hold the copyright for these, there are no copyright issues.
Entering References
References are to follow the current American Psychological Association (APA) guidelines. We have placed a summary of these guidelines on the web at 
https://www.informingscience.org/Uploads/APA_7ed.pdf
List the sources alphabetically at the end of the paper under “References” using a Heading 1 style. Place entries in alphabetical order according to the last name of the first author. Within the text of your paper, cite sources by placing the author’s last name and the date in parentheses.
Reference list. In the reference list, when a work has up to (and including) 20 authors, list all authors (last name followed by initials). Place a comma after the last name of each author and after that author’s initial(s). Place an ampersand (&) before the last author. If there are more than 20 authors, provide last names and initials of first 19 authors, insert three ellipsis points, and add the last author’s name. Follow the authors by the date, the title, and the source.
In-text citations. If a work has two authors, include both authors in each in-text citation (Boyd & Cohen, 2003). If the work has three or more authors, in all in-text citations place only the first author followed by et al. (Gill et al., 2019).
[bookmark: _26in1rg]DOIs and URLs in Reference list. When citing sources from the Web, include the year of publication or the most recent update. End the entry with a DOI if it has one. If it does not have a DOI, end the entry with the URL. Do not end the path statement or a DOI with a period. DOIs can be found by going to https://search.crossref.org/references and entering the reference entry. DOIs begin with https://doi.org/ followed by numbers and letters that identify the document, for example, https://doi.org/10.28945/2714
Author
(Leave this blank when submitting for review.)
Include one or two short paragraphs about each author. Please include a head and shoulder photo of each author. You should include this photo and bio when you are asked to upload your final, formatted, camera ready copy. However, if you need to, you can send the photos by email to Publisher@InformingScience.org as separate attachments and we will insert them for you.[image: j0284979]
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